USE OF REVIT

REVIT FOR INTERIORS:
ESSENTIAL SKILLS

Are you an interior designer thinking about using Revit? If so, wait no longer. Revit is a terrific tool for
interior design. In this session, we'll explore some of the essential skills you will need to begin. We'll
lock at creating Revit models and setting up grids. We'll add walls, doors and FFE. Place rooms and load
them up with useful data and then use that data to help build schedules, create color fill plans, finish
plans and quickly place room tags. And of course we'll talkk about importing CAD files too. Wrap it up
with some export options and when you leave here you will be ready to begin your first Revit interiors
project. If you are already using Revit for intericrs, there will be some tips for you too, but this class is
aimed at those just getting started. VWait no more! See for yourself what Revit has to offer.

LEARMING OBJECTIVES

-
-
-

See how easy it is to build walls, doors and other elements.
Learn to bring in a CAD file and use it to help in basic layout
Add rooms, schedules and tags.

Learn how to ocutput your work to PDF or other deliverables.

E. Muino
Guide for Fundamentals Digital Media for Interior Architecture 2017 Class



Introduction

If you are involved in Interior Architecture and Design and are considering the use of Revit in your
practice, then you have come to-the right place. In this class, we will explore many of the features and
benefits of Revit Architecture for interiors projects. The first session will introduce concepts and
procedures of using Revit for interiors. The second session will be a hands-on lab where you will get the
opportunity to try out some of the techniques first-hand.

There are many entry points to adding Revit to your existing worlkflow. The most important thing to
realize is that you can take it slowly and implement the features that matter most to your practice as
project needs dictate and business cases develop. Whether you are interested simply in creating more
tightly coordinated construction document sets or wish to implement Building Information Modeling
(BIM) into your practice, Revit has something to offer. In the topics that follow, several tips will be
presented for ways to achieve common task required by interior design using Revit Architecture.

Getting Started

If you have not yet begun using Revit, then a few obvious questions typically are at the top of the list:
Why should we use Revit! How do we get started? Is Revit hard to learn! What benefits will we see!
Can we use Revit with AutoCAD files? And many more. This paper will try to address many of these

questions and more. For an answer to “why” we should use Revit, there are many potential answers,
but consider one of my favorite Revit features: The Project Browser (see Figure |).
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FIGURE | = SELECT AND EDIT IN ONE YIEW AFFECTS ALL VIEWS AUTOMATICALLY

In Revit, you create a single virtual model of your project. Revit allows you to view this model in a
variety of ways including: floor plans, elevations, sections, ceiling plans, details, 3D views and schedules.
Further, you can edit the model from any view and changes automatically appear in all other views. Since
there is a single model that is simply displayed as a plan, section, schedule or 3D a change to one view is
a change to all. Views cannot get out of synch. By itself, this feature alone can be enough to justify using



Revit over more traditional approaches where there are dozens of disconnected drawings that
represent the same portions of the project and must be manually coordinated.

Edit in any View
If you are new to Revit, getting comfortable with the project browser is definitely the place to sart.

The easiest way to get started with this feature is to cpen an existing Revit project and open several
views onscreen and make some simple edits.

1. Open the 01 floor plan, the Longitudinal section and the Room Schedule. Tile the windows.

2. Move a door in plan for example and watch it move in section.

3. Type a new name in 2 Room Schedule and watch the tag in the floor and ceiling plans update.

4. Delete an element from one view and watch it disappear in all others.
The easiest way to conceptualize this concept is to think of the actual finished building. Even though you
might draw a door several times in your documents: once in plan, once elevation, again in schedule,
there is really only one door in the actual building. If this door changes size, location or is removed, it

affects only cne “real” door, but in traditional procedures, several edits would be required. In Revit, it is
built in the Revit model as it is in real life: one real door, one Revit door. Simple.

Basic Building Elements

Walls, Doors, Rooms and Ceilings offer the basic building blocks for many projects. In addition, you can
add furniture, casework and equipment and even build specialty items like glass parttions and perform
detailed area calculations. Revit offers tools for each of these items. Draw walls in plan by designating
overall parameters like height and wall type and draw by picking start and end points. Walls can be
straight lines or arc curves. Doors automatcally cut holes in walls. Ceilings find the shape of surrounding
walls automatically or you can draw custom shaped ceilings in any shape you reguire (see Figure 2).
Egquipment, furniture and casework items are placed from a library of content provided with the
software or you can locate additional items online at various content provider websites or even build
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FIGURE 2 = VARIOUS MODEL ELEMENTS SHOWN IN SECTION



There are the obvious benefits of using such objects. For example, rather than draw two parallel lines
for each wall, a single wall element is drawn. When two Revit walls intersect, they join automatically
creating clean intersections with the additional trimming required of individual lines in CAD. When you
place doors, they cut holes in the host walls. Railings, floors and ceilings can all be easily derived from
surrounding geometry with little additional effort. Some of these benefits were already noted.

Just the Basics
Let's create a new model and add a few basic elements to get the hang of creating Revit elements.

1. From the Application menu, choose: New > Project. Choose the Default Architectural Template and
click OK.

2. Onthe Architecture tab, click the Wall tool. On the Draw panel, click the rectangle icon and then click
two opposite corners onscreen to place a rectangle. (It can be any size for now).

3. Onthe Draw panel, change to the Start, End, Radius arc.

4. Click the first endpoint on one of the walls, the other on the wall opposite it and then click in the
middle somewhere to set the radius.

5. Click the Door tool next and add a few doors (see Figure 3).
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FIGURE 3 = CREATE SOME WALLS AND DOORS



10.

On the Architecture tab, click the Floor toel. Accept all the defaults and then click each of the four
exterior walls (not the curved wall). On the ribbon, click the Finish Edit Mode button (large green

checkmark).

On the Architecture tab, click the Component tool. A Desk will be loaded by default. Click to place
one in the model. Tap the SPACEBAR to rotate the desk and then click to place another.

On the ribbon, click the Load Family button. Browse to the Furnifure folder and load a chair family.
Place a few chairs.
On the Architecture tab, click the Room button. Move the cursor into one of the enclosed spaces and

then click to place a room. Repeat in the other space (see Figure 4).
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FIGURE 4 - ADD A FLOOR, SOME FURNITURE AND ROOMS
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On the Project Browser, double-click the Level 1 ceiling plan to open it.
On the Architecture tab, click the Ceiling tool. On the Properties palette, set the Height Offset From

Click inside each room to place ceilings.

Stay in the ceiling tool, on the Properties palette, from the Type Selector, choose: GWB on Mil. Stud.
Set the Height Offset From Level to: 8'-0".

On the ribbon, click the Sketch Ceiling button. On the Draw panel, click an enclosed shape like the
circle or ellipse.

Draw the shape within one of the rooms and then click the Finish button (green checkmark).

On the View tab, click the Section tool. Click two points cutting across the plan.
Right-click and choose: Go To View (see Figure 5).
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FIGURE 5 = ADD A SKETCHED CEILING
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You can continue adding elements in similar fashion. Each kind of element has unique characteristics that
emulate the real-life elements which they represent.




Design sketches and DWG files

At a high level, considering just project browser and the single building model with its multiple views and
the enhanced productivity of using Revit elements to create your building model we already have some
compelling reasons to consider Revit for our next project. 5o the next queston is likely when should we
add Revit to the process! Should the project be begun immediately in Revit, or should it be transitioned
there after some preliminary work in other programs? Maturally the answer depends. If you have a team
of experienced Revit users, you can begin right away in Revit without the need to start in other
sofoware first. If the team is new to Revit, there is usually a productivity dip before people get up to
speed with the Revit process. At the early phases of a project, the budget may not be able to absorb the
associated costs of the learning curve.

Even with an experienced teamn, sometimes folks will prefer to work in other design tools in schematic
design. These might include AutcCAD, SketchUp or other 2D and 3D design packages. Furthermore, many
building owners and clients will provide base building information as 2D CAD files often in DWG format
Revit can import CAD files and many popular raster file formats. if you receive such a file, do not feel
compelled to trace or otherwise "Revitize™ this background file. It is possible to import the background file as
is and work in Revit directly on top of the file without editing it or converting it. The specific needs of the
project will largely dictate the appropriate course of action. If editing of the background is required (if
renovation of an existing space is part of the scope for example), you will have to weigh the pros and cons of
tracing the CAD file in Revit vs. performing the necessary edits directdy in CAD.

It is possible to begin using Revit at nearly any phase of the project. Maturally, the earlier that you
incorporate Revit into the team's workflow, the less potential there is that rework will be required.
Regardless of the phase when you begin using Revit, keep the following in mind with respect to CAD
files used in Revit projects:

CAD files can be imported or linked. An imported file is embedded in the Revit project and cannot be
updated if the original CAD file is modified. Linked files maintin a connection to the original CAD file. If
the file changes, you can reload the changes using the "Manage Links" dialog. This is typically the
preferred approach for most CAD files, particularly if work is being conducted in CAD concurrently to
the work performed in Revit (see Figure &).
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FIGURE & = LINK CAD AND IMPORT CAD BUTTONS ARE FOUND ON THE IMPORT TAB

If you Import a CAD file: Do not explode! Exploded CAD files bloat your Revit project file size and
create many unnecessary line styles, materials and other project settings and standards that can be
difficult to manage andfor purge. If editing of the CAD file is required, it is much cleaner to edit the file
in the original application and then re-import it into Revit

If you Link a CAD file: You cannot explode a linked file, so this is not a concern when linking. Use
the Manage Links dialog (Insert tab, Link panel) to modify the settings of the linked file and to reload it



during your Revit session. You can also unload it and convert it to an Import with the Import button
(this breaks the link).

Pay attention to the various settings at the bottom of the “Link or Import CAD Files” dialog. Several
options are available when you link and import CAD files.

Current Yiew Only: This checkbox determines if the CAD file will behave like model or detail
geometry in Revit. If you leave this box unchecked, the CAD file will appear in all views (behaving
essentially like Model Lines). If you check this box, the CAD file will appear only in the current view
(behaving essentially like drafting lines). If you have a CAD file for each floor of a building, you will
probably want to check Current view only. If you have a base building file that is the same on multiple
floors, you will want to clear the checkbox so that it will appear on all views. If you need it in some
views, but not all, you will need to clear the Current view only checkbox and then hide it individually in
views that don't require it. You can use the “Visibility/Graphic” overrides dialog to hide it, or use the
Hide tool on the ribbon.

Colors: settings include preserve, invert and black and white. AutoCAD typically uses a black
background and Revit typically a white one. If you want to show and print the CAD file in color, Invert
is a good choice since the AutoCAD primary colors may not read too well on a white background.
Invert (or preserve) are good choices if you are tracing the background. Having the color display
onscreen will make it easier to see when you have finished tracing the lines in the file.

If you plan to print the file from Revit, use Black and White.
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FIGURE 7 = LINK A CAD FILE

Positioning: Many options are available. Common wisdom would dictate favoring the Origin to Origin
option. However, the way that Revit manages coordinates is different than AutoCAD, so this may not



be all that necessary in most Revit projects. Whichever cption you choose, you can save the
coordinates in a “shared coordinate” system after linking the file. Consult the online help for more
information on Shared Coordinates.

Tracing a CAD File

If you find you need to “convert” a CAD file to a Revit model, unfortunately there is no automated way
to do this. Tracing the underlying CAD file is your only option. However, Revit is very smart about
interpreting the CAD file. For example, Figure 8 shows that Revit will find the centerline between two
lines in the CAD file as you trace with the Wall tool. This will speed the task of tracing the file.
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FIGURE B = TRACING A CAD FILE WITH WaALLS

Lock carefully at the right side of the figure and note that you should draw walls continuous and not
break them at doors and windows. Instead, when you are finished adding walls, come back and add door
and window elements. These will automatically be hosted to the walls and cut openings.

Design Options

Creating design schemes with traditional design tools would typically require that multiple copies of each
drawing or model be created and maintained. With the Design Options feature in Revit, you can maintin
a single model that contains one or more schemes within it. With this methodology, you can explore and
present multiple design possibilities while avoiding much of the repetition and duplication of traditional
procedures. Furthermore, Revit's fully coordinated building information model is maintained and updated
“on-the-fly” accurately representing each scheme as various Design Options are made current.

The Design Options feature (see Figure 9) gives you a flexible way to create, manage, and present
alternate design proposals. Using one or more “Option Sets” each containing various “Options,” you are
able to manage variations in your design that deviate from the “Main Model.” You can present each
option independently in separate Revit views and sheets including schedules that will accurately reflect
the active option.
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FIGURE 9 = ACCESS DESIGH OFTIONS ONM THE STATUS BAR OR MAMAGE TAB

The following are some basic definitions of commeon terminology used in conjunction with the Design
Options functionality.

Main Model—This term is used to describe any part of your Revit design that has no variation under
consideration. In other words it does not have any Design Options associated with it Before you add
Design Options to a project, everything is part of the Main Model. Once you begin adding Options, you
can move elements from the Main Model to one or more Options.

Option Set—FEach work area or portion of a project to which you will consider design variations will
become an Option 5et. For example if you wanted to consider variations for the entrance to your

building, you might create an Option Set called “Main Entry.” To this set, you could add an "Option” for
each variation you wish to consider.

Option—Each Option Set will contain at least one Option, but to be meaningful. you should include at
least two Options. An Option represents a discreet design variation you wish to consider in your
project For example, if you had a *Main Entry” Option Set as suggested above, you might have two
Options within it called *5ingle Door Entry” and "Double Doar Entry.” Each Opton would show the
appropriate geometry to represent the design intent of that Option. Both options would contain a copy
of the wall that hosts the door variations.

Primary—The Primary Option is simply the Option that you or your client favors. It is the most likely
to be accepted and implemented in the final design. YWhen you make an Option Primary, all views in the
project will update to reflect the change. You do not need to make an Option Primary to edit it In face,
making an Option Primary is typically done late in the process as a step in the process of accepting an
Option and removing others from consideration (see below).

Accept Primary—This function merges the Primary Option in a Set back into the Main Model and
permanently removes all athers from the project.
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The Design Options toolset is intended as a means to manage the design variations (schemes) under
consideration. As such, it is assumed that at some point in the design process, one of the Options will be
chosen over the others. The Design Options tool is therefore meant to be temporary. While you could
maintain more than one Option indefinitely, the intent of the tool is that one of the Options under
consideration will ulimately prevail. The tools will be most successful when used in conjunction with the
workflow described herein. However, lilke many aspects of architectural practice, procedures and
workflows can and often do vary from firm to firm and even project to project within the same firm.
Therefore, while the intention of Design Options toolset follows a narrow scope and focus, you will find
that with a little creativity, it can be used successfully even when deviating from its “intended workflow.”

The basic procedure for Design Options is as follows:

¥ Create an Option Set contining two or more Options.

¥ Add geometry to each Option.

¥ Create views (in Project Browser) with Design Option overrides applied to present each scheme.

¥ Upon approval by your client, make an Option Primary and then “accept” the Primary.

Room and Area Calculations

For basic square footage calculations, you can query the area of the room elements in your project.
Rooms provide basic “finished” area, volume and simple finish designations (see below). Also, rooms
report the name and number for tags and schedules. For more control over square footage calculations,
Revit has a special floor plan type called and Area Plan. Area Plans use Area Boundary lines and Area
elements to define areas and calculate their values very precisely (see Figure 11).
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The basic procedure for creating an Area Plan is as follows:

¥ On the Home tab, on the Room & Area panel, click the Area tool and choose: Area Plan.

¥ In the “Mew Area Plan” dialog, choose the Type of Area plan (Rentable or Gross Building), the floor
level and the scale and then click OK.

¥ You will be prompted to automatically create boundary lines. If you answer yes, Revit will atcempt
to determine the location of the area boundaries (center of wall, face of glass, etc.) based on the
rules built into the system. Consult the online help for more information. You can always override
any automatically generated boundary lines by adding your own manually andfor adjusting the
automatically created ones.

¥"  Click the Area tool again and choose Area Boundary Line to add additional boundary lines. Your
goal is to enclose each regicn that you wish to measure.

¥ Once all Area Boundaries are placed, use the Area tool to add Areas. Simply click in an enclosed
region to add the Area. Optionally rename them.

¥ (Generate a schedule to see a list of all areas with their values.

There are two schemes included in the out-of-the-box templates. Gross Building Area and Rentable.
Gross Building Area will automatically generate Area Boundary Lines to the cutside edge of exterior
walls, while Rentable will look at adjacencies and inserts in walls to determine if lines should be placed at
the face or center of the wall or at the face of glazing. After you add area elements, you can select them
and edit their properties. The Area Type parameter is useful to define each area within a set list of
types. For the Gross Building Area scheme, two Area Type values are provided: Gross Building Area
and Exterior Area. For the Rentable scheme, Area Type values include: Building Common Area, Office
Area, Exterior Area, Floor Area, Major Yertical Penetration and Store Area (see Figure |2). Add the
Area Type field to a schedule to sort or sub-total based on the function of an area. The values in the
Area Type list are fixed in the software and cannot be edited directly.
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FIGURE | 2 = ASSIGN AN AREA TYPE TO MAKE SCHEDULING ANMD REPORTING MORE ACCURATE

Each type of Area Plan will create a separate branch on the Project Browser. If you need to calculate the
areas on a particular plan more than one way, you can create another Area Plan type. On the Home tab,
click to expand the Room & Area panel and then click the Area and Volume Calculations button. On the
Area S5chemes tab, you can click Mew to create another scheme. This will allow you to create a new
Area Plan with alternate boundaries, areas and schedules.

Color Schemes

Color schemes can be applied to plan, section and elevation views and apply colors and patterns to
rooms or areas based upon a particular rule. Any parameter of a room or area object can be used as a
criterion for the color scheme. For example, if you have assigned each of your area elements (from the
previous tip) to an Area Type, you can create a Color Scheme that displays Building Common Area in
one color, Office Areas in another color and so on. You can even add a legend to the view that defines
parh possihle color or parrern used in rthe view, Color Schemes provide an effecrive way ro display

useful information in a graphical way.

To create a color scheme, be sure you have either Rooms or Areas in a view and open that view

OnsCreen.

¥ On the Home tab, click the Room & Area panel to expand it and then click the Color Schemes tool.

v"  From the Category list at the left, choose either Rooms or one of your Area Schemes as
appropriate. (Only Area Schemes for which you have created Area Plans will appear in the list).

¥"  Beneath Category, a Scheme will be suggested. You can use this one, or use the icons at the bottom
to duplicate it and create a new one. Each S5cheme can only apply to one parameter at a time, so if
you wish to theme by Area Type and Area, you will need to create two schemes and apply them to

different views.



v" On the right side, input a title and then choose what parameter will be used from the Color list. A
collection of colors will appear automatically based on the elements appearing in the model in the
current view.

v"  Edit the color or pattern of any of the items if you wish and then click OK.

v To apply the Scheme to a View, edit the View Properties and choose it for the Color Scheme
property. There is a Legend button on the ribbon if you wish to add a legend to the view (see Figure 13).
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FIGURE |3 - CREATE A COLOR SCHEME AMD APPLY IT TO A VIEW

You can create as many Color S5chemes as you wish in a project. However, you can only apply one
scheme to a view at a time. To display the same view using different schemes, duplicate the View first
and then apply different schemes to each one.

Finishes

Designating finishes is a big part of an interior design project. In this area, Revit offers a few possibilities.
The simplest way to designate and report your finishes is using rooms and a room schedule. This is
effective when the finishes in each room are simple and do not vary from surface to surface (the entire
room uses PT-1 for example). Room objects have simple text fields for inputting finishes. The defaulc
project template includes a field for Wall, Base, Floor and Ceiling finishes. To use this functionality, add
rooms, edit the room's properties and fill in the values for Floor Finish, ¥Wall Finish, etc. Create a room
finish schedule that reports these fields.

For spaces with more detailed designs and multiple finishes per surface, an alternate solution is required.
Revit offers a few alternatives for such cases:

Modeling—For the sake of completeness, it should be noted that you could choose to model all
surface changes. This would require splitting walls, floors and ceilings into multple elements, and then
creating and assigning materials to each such element. Theoretically this approach would maximize the
amount of data you could extract from your model, and some might argue was a more “accurate™



rendition of the true conditions that would ultimately be builc. However, the amount of additional effort
required to build such a model would make such an approach impractical. Further a model buile this way
would be more difficult to maintain as the project progressed. VWith each decision you make in a
project, be sure to carefully weigh the effort required to complete a task with the expected benefits of
performing the @sk. The amount of effort expended should not exceed the benefits gained (see Figure

| 4).

FIGURE |4 - JUST BECAUSE YOU CAN, DOESN'T MEAN YOU SHOULD. ALWAYS KEEP THE EFFORT
vS. BEMEFIT AMALYSIS IM MIND AS YOU MAKE PROJECT DECISIOMS

Split Face—Another approach is the Split Face tool. With this tocl, you can split the surface of a
model element into two or more distnct regions. On the Modify tab, on the Geometry panel, click the
split Face tool and then select a face of a single model element such as a wall or floor. This will enable
sketch tools and allow you to sketch the shape of the split face. Once you have completed the sketch,
use the Faint tool to apply a different Material to the Split Face. Revit will literally paint the material
onto the surface in this region. Unlike the modeling approach, the underlying structure of the element
will be unaffected by Split Face and Paint; only the surface is affected. However, painted Materials will
appear in schedules and you can even tag them with Material tags (see Figure 15 ).
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FIGURE 15 — USE SPLIT FACE AND PAINT TO APPLY FIMISHES TO THE SURFACES OF ELEMENTS

To schedule materials, you create a Material Takeoff. This is simply a schedule that can report on the
Material properties of elements in your model. To limit this takeoff to just Materials that are finishes,
add a prefix in front of each of the material names you wish to include on your finish schedule. Then use



the filter option in the schedule to include only Materials whose name begins with the prefix you

designate (see Figure 16).
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FIGURE |6 = CREATIMG A MATERIAL TAKEOQFF WITH & FILTER FOR JUST “FIMISHES™ YIELDS A

Floor finishes—You can do floor finishes the same way. Simply use the Split Face and Paint tools on
the floor element in a plan view. However, you cannot hide the edges of the split faces automatically. 5o
in views where you don't want to see them, you have to hide therm manually, usually using the inewark

tonl.

Finish schedules—As noted, use a Material Takeoff for a Finish Schedule. When you first create it,
decide if you want a single material list for the entire project. or want separate lists for walls and floors.
If you want a single list, use the <Mult-Categary™ option when you create the Material Takeoff. If you
wish to have a separate wall or floor finish list, you can choose the appropriate category instead (see

Figure 17).

ulti-Categary Materal Takeoff
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FIGURE | 7 = UNDERSTANDING THE PROPERTIES OF A MATERIAL TAKEOFF




O the Fields @b, the only difference between a Maverial Takeoff and regular Schedule is the availabilicy
of “Material” fields for the Material Takeoff. Material fields are prefixed with “Material:" VWhen you
select one of these fields, you are instructing Revit to give you the information about the Material
instead of the object to which the Material is assigned. You can tell Materials that have been “painted”
onto a surface in the schedule if you include the Material: Volume field. The volume of painted Materials
will be zero. You can also use the Material: As Paint field specifically to identify those that are painted.

The split face and paint approach can be effective but typically requires more effort to accomplish than
what folks are currently accustomed to. This is because the sketched split regions must make enclosed
shapes in order to be painted and each element must be selected to use the tool and in some cases,
making those selections will be challenging and might require additional views to be created.
Furthermore, each Material must be defined in the “Materials” dialog. However, the benefit of the
approach is that it is applied to the model and will therefore appear in all views and we can even capture
the area of painted Materials giving us a useful tocl to make simply guantity takeoffs. Despite these
potential benefits, in your own effort/benefit analysis, you may decide that these benefits do not justify
any additional effort. But effort expended is not the only potential downside to split face. Unfortunacely,
once you split a face, it will be “split” everywhere. 5o this means you have to sometimes go through
quite a bit of work to hide the edges of the split surfaces in views that do not need to show them.
There is no mechanism to hide split faces using level of detil or even visibilicy/graphics. 5o this much be
accomplished with the linework tool, which can be a significant amount of work!

Generic Annotation Symbols

The methods above give effective ways to create a Finish Schedule or Material Reference List. However,
it may not always be practical to use Split Face and Paint. Therefore, what can you do when you wish to
simply callout material designations on a drawing without changing the model in any way? Can this even
be done in Building Information Modeling and Revit? Well, it certainly can be done. The more important
question of “should it be done?” is one you should consider carefully. But assuming that in your
effort/benefit analysis, you have decided that modeling finishes is not desirable, generic annotations offer
a nice alternative.

You can simply sketch lines on the views to indicate finish transitions and call them out with generic
annotation symbaols. This is actually easy to do except for some unfortunate terminology obstacles. In
Revit, a “Generic Annotation”™ family is a simple 2D symbol. It can optionally have parameters (fields) in
which we can input values. (If you are familiar with AutoCAD, it is like a block with attributes). The first
terminclogy obstacle is this: "Generic Annotation” and “Symbol™ mean the same thing in Revit. Generic
Annotation is the kind of family and symbol is the tool used to insert them in a project. 5aid another
way, you use the Symbol tool to insert generic annotation families. To create “symbols™ you use the
Generic Annotation.rft family template. Clear as mud?

Symbols (generic annotations) are 2D annotation and like other 2D annotations appear only in the view
to which they are added. Let's assume that you wanted to add finish designations to a plan or interior
elevation. 5imply draft any transitions between finishes using detail lines (also view-specific) and then add
a generic annotation symbol to call out the finishes. To input the finish value, you just click on the
symbol and edit the value. Keep in mind that symbaols like this are not linked to anything in the model. 5o
this is not very “BIM" like, but may in fact be perfectly suitable for the task at hand. Despite this possible
limitation, there is one important upside. YWe can create a schedule of all generic annotation symbols
that report all of the values input into the symbols! To create such a schedule, we encounter the second



terminology obstacle. A generic annotation (or symbol) schedule is called a "Note Block.™ 5aid another
way, a note block will list all instances of your generic annotation symbols and their associated values!

Got it? The family is a generic annotation, the tool is symbel and the schedule is note block (see Figure

18). Weird.
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FIGURE | B—GENERIC ANNOTATION FAMILIES ARE INSERTED WITH THE 5YMBOL TOOL AND
SCHEDULED WITH A NOTE BLOCK

Using Generic Annotation for Finishes

So, even though the solution is not very “BIM-like” it is still more effective and powerful than whar we
are used to with traditional methods. Let’'s walk through the steps. Our goal here is to create a finish
symbol with finish designation displayed and hidden fields for other values and then report all instances
of this symbol on a schedule.

1. From the Application Menu (big “R"), choose: New > Annotation Symbol. In the “New Annotation
Symbol® dialog, select the Generic Annotaifon.rft template and click Open.
There are two reference planes marking the insertion point of the symbol and a red note with some
instructions. You can read the note and then delete it once you are done. The note instructs us to
change the category. But in our case, we need the category to remain: Generic Annotation so we will
skip this and simply delete the note. You can use this template to create other kinds of annotation and
in those cases you would change the category firsc

2. Delete the red note. On the Create tab, click the Line tool and draw the graphics for your symbol.

It can be any shape you like and should be drawn centered on the two reference planes onscreen.
Draw it the size it will be on paper when printed. For this example, | am doing an elongated hexagonal
shape with an overall widih of 7/16" and a height of 5/32". The exact shape you draw is not important.
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FIGURE | 9—DRAW THE GRAPHICS OF THE SYMBOL CENTERED OMN THE INSERTIOM REFEREMNCE
PLANES (DIMENSIONS HERE ARE FOR REFEREMCE, YOU DO NOT NEED TO DRAW THEM)

3. Onthe Create tab, click the Label tool (a Label is a piece of text that references a parameter so that
you will be able to edit the value in the project). Click in the middle of the screen fo place it.

The “Edit Label” dialog will appear. Since this is Generic Annotation, there are no predefined
parameters. We can add any we wish to include in our final Finish Schedule.

4. Click the Add Parameter icon (bottom left).

In the “Parameter Properties” dialog:
For the Name, type: Finish Code.
Choose the Instance radio button.
For the Type of Parameter, choose: Text.
For Group parameter under, choose: Materials and Finishes or Identity Data.

Optionally, click the Edit Tooltip button and type something like: “Input the finish code
designation” and then click OK.

6. Click OK to create the parameter (see Figure 20).
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FIGURE 20 - CREATE A PARAMETER FOR THE FINISH CODE DESIGHATION

7. Add other Parameters if you like, such as: Descnption, Manufacturer or Model Number. Set them all
as Instance.




Select parameters o add to the label, Parameters will be combined into a single label.

Select Finish Code and then click the Add Parameter fo Label icon in the middle. Change the Sample
Value to something like X-1 and then click OK (see Figure 21).

Enber samgphe values to represent this label in the famiy environment. [ Wirap betwesn paramsters only
Categary Parameters Label Parameters
Select avaliable fields from: Farameter Name |Splm| Prefic I Sample Value J Suffine [Emtl
Ganeric Annotations - 1 |Finzsh Code n | -1
e — T
Moddrﬁmh:—r 4 Add parameten(s) to lsbel j
BhEWY tE 4E &

FIGURE 2|1 -ADD THE CODE TO THE LABEL

9.

10.

1.

Save the family file (Name it something like: Finish Tag (Manual).rfa) and then on the ribbon, click
the Load into Project and Close button.

In the project, place a few instances of the symbol.

When you first load it into the project, the Symbol tool will already be active. You can cancel the
command if you are not in the correct view. To get back fo the command, remember, to place a
generic annotation family you use the Symbol tool.

On the Annotate tab, click the Symbol tool. Use the Detail Line tool to draw any finish boundaries as
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required (see Figure 22).
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FIGURE 21 - ADD SYMBOLS AND EDIT THE VALUES ONSCREEN



12.  Like other annotation, you can select the-symbol after you place it and then use the tools on the
ribbon to add leaders if required. You can also add leaders while placing it on the Options Bar (see

Figure 23).
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FIGURE 213 - ADD LEADERS WHILE PLACING SYMBOLS OR ADD THEM LATER

13.  Toedit the hidden fields, select the symbol and edit its properties on the Properties palette. (Or wait
till you have a schedule and edit there).

14, Add a few symbols and fill in various values on the Properties palette.

Adding the Note Block Schedule

Once you have the symbol and some values input in them, you can create a note block schedule.

On the View tab, click the Schedules drop-down and choose: Note Block.

2. Each of the generic annotation symbols in the project will be listed. Select your finish symbol, type a
name for the schedule such as: Finish List and then click OK.

3. Inthe “Note Block Properties” dialog, add all the fields (except Type). Rearrange the order as desired.

4. On the Sorting/Grouping tab, you can uncheck the “Itemize every instance” checkbox and you will
end up with only one entry for each unique value.

For example, if you want P-1, P-2 and P-3 to each be listed only once, uncheck this box. Further,
setting it up this way allows you to easily edit the other fields associated with P-1 directly in the
schedule rather than having to edit them individually in the project views. If you want to do a quality
check and see if you have redundant values, turn itemize each instance back on. You can even have
two versions of the schedule, one itemized for checking and editing, one not itemized as your final
version (see Figure 24).
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FIGURE 24 - ADD SYMBOLS AND EDIT THE YALUES ONSCREEN

Reporting annotation

Another interesting characteristic of generic annotation is that you can include dimension parameters
that behave like reporting parameters in the labels of generic annotations. VWhile | find this very
intriguing, | have not come up with a really practical use of this yet. It’s a blog post on it here:



http://paulaubin.comiblog/generic-annotations-in-revitk

Feel free to visit that post to learn more.

Other Tips

There are many more topics worthy of discussion. Hopefully in this short tour of Revit features relevant
to the Interior Designer, you have found some compelling reasons to give Revit some serious
consideration for your next project. Here are a few more items/questions to consider:

2D vs. 3D—Often people get the impression that in order to use Revit, they must model everything in
3D. | am not sure why they get that impression, maybe it is all the hype out there telling them to do
everything in 3D... Much of what you build in Revit will be 3D. 3D can be very useful and powerful.
However, it is not necessary to build everything in 3D. Furniture and equipment are terrific examples. If
you plan to do renderings of the 3D space and wish for the furniture to appear in the rendering, then
you will be required to have 3D models of your furniture. But, if you are only concerned with creating
furniture plans and schedules, 3D will not be required. YWhen you build the family, simply add enly 2D
geometry in plan and that is all you will see in both plan and 3D views. This is also an excellent way to
quickly leverage your existing symbol libraries. You can literally import the AutoCAD 2D symbols
directly into families in Revit (see Figure 25).
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FIGURE 25 = FAMILIES CAN CONTAIN SIMPLE 2D SYMBOLS IF 3D 1S NOT REQUIRED

MNote: Complex AutoCAD geometry in families can impede performance. 5o while simply importing AutoCAD
files directly into a family is the fostest way to migrate a library, a better long-term solution will be to consider
converting all such AutoCAD files to native Revit 20 or 3D geometry.

In-Place Families—for very custom “one-off " conditions in a project that will not be reused in other
projects, consider In-Place families. In-Place families have the benefit that they are built “in-place™ in the
context of your project (see Figure 16). 5o you can easily take advantage of surrounding geometry to
build them. However, they are not portable at all, so if you build one in a project, you will not be able to
use it in another project. In fact, copying it within the same project is a bad idea as well. This will make a
whole new family, even though you copied it. 5o unlike normal families, changes made to one copy will
MOT propagate to other copies when you copy in-place families. 5o, if you need it in more than one
location, or in ancther project, build a regular family instead.



FIGURE 26 - EXAMPLE OF AN IN-PLACE FAMILY

In-place families can be good choices for custom millwork conditions like the one shown here, or
custom ceiling conditions, etc.

Moving Room Tags outside of rooms—You can move all tags to a new location. With room tags
however, the room tag must remain inside the Room boundaries or it will lose its association. To
overcome this, add a leader to the room tags.
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FIGURE 27 - TO MOVE ROOM TAGS OUTSIDE THE ROOMS, ADD A LEADER

Schedules—When you choose your fields for a schedule, be sure to look at the “Select available fields
from" drop-down list (see Figure 28). Certain object types will allow you to query fields from other
objects. For example, when creating a furniture schedule, you can choose fields from Rooms. This will
allow the furniture to report in which room it is located and even list the occupant or other relevant
data from that room.
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FIGURE 28 — CERTAIN CATEGORIES ARE *‘ROOM AWARE" AND CAN REPORT PROPERTIES FROM
THE CONTAINING ROOM

Add Rooms to a Schedule—If you have room schedule, you can actually add rooms to your model
directly from the schedule. Such rooms will appear on the schedule as *Not Placed.” To do this, open a
room schedule. On the ribbon, on the Rows panel, click the Insert Data Row button. This will add a
room to the schedule but not the model. You can fill in its name and other properties directly in the

schedule. Later, in a plan, you can place the Room by choosing it from the Options Bar when adding a
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FIGURE 29 - ADD ROOMS TO A SCHEDULE AND PLACE THEM LATER

There is 3O much more to Revit than we had time and space to cover here. 5o please do continue to

explore. | am sure that if you had any doubt about Revit and its usefulness to Interior Design, you will be
pleasantly surprised!
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